
CH-1 CONCEPT  OF  NETWORKING
Exercises
A. 1. Network, 2. Area of Network, 3. PAN, 

4. Tree, 5. Rights
B. 1. True, 2. True, 3. True, 4. True, 5. False
C. 1. (b), 2. (a), 3. (a), 4. (b), 5. (b)
D. 1. Importance of A Network

 Networks have made communication 
cheaper and faster and also help in 
saving resources. Let us understand the 
importance of network in our daily life.
Share and Save Resources: Computers 
on a network can share resources like 
printers, modems, scanners, plotters, 
CD drive, USB ports etc. This allows to 
cost serving.
Storage Media: When a computer 
network is created, one computer acts 
as the main computer or the server. 
This Server serves or distributes the 
software or hardware that the other 
networked computers would required.
Effective Backup: You can make two 
copies of important files and save them 
on another networked computer or the 
server. If one system faces hardware 
failure, the data will not lost, which 
ultimately is the most important.
Effective Means of communication: 
A network builds a very effective 
means of communication, as it 
provides cheap and quick 
communication.
Sharing information: Information can be 
easily means of communication, as it 
provides cheap and quick 
communication.
Sharing Information: Information 
can be easily shared among the 
computers connected through a 
network.
Makes Administration Easy: The 

person can sit at one place and still 
keep an eye on all the computers being 
used.
Effective Security Measure: The security 
of a network is managed through 
passwords and user names. Also, when 
all the important files are saved at one 
place, it is easier to protect them.

2. A network is made up of different 
parts or components are given below:
Network Interface Card (NIC): It is 
an important hardware device that 
differentiates between a networked 
computer and a stand-alone computer.
Communication Media: It can be 
wired or wireless.

3. Wired Network: Electrical cables such 
as (twisted pair coaxial cable or optical 
fibre) are used to carry signals from 
one end to other.
Wireless Network: They do not require 
cables rather than signals are transmitted 
using Bluetooth, Infrared, Microwave or 
Radiowave.

4. Following are  the types of topologies:
Bus Topology: In this topology, a 
single cable, known as a backbone 
with multiple points is involved. All 
the computers, printers and other 
hardware are connected to this cable. 
Any electronic signal passed by any 
node can be received by all the nodes 
on this cable, as the signal can travel 
in both directions. The cable has 
terminators at its end so that the 
signals can be absorbed by them. 
They do not clutter the network line.
Star Topology: In this topology, all 
the computers are connected to a 
central hub/switch. All the computers 
are connected separately with 
individual wires to the central hub.
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Ring Topology (Circular Topology): 
This topology uses multiple links to 
form a loop of computers. Each 
computer is connected to the loop, 
thus forming a kind of a ring or a 
circle. A message or a token goes 
round the loop continuously. All the 
computers or the nodes are equipped 
with a Token Ring Adapter Card 
(TRAC), which helps them to read 
the token or the message that passes 
through the loop continuously.

Tree Topology: Tree topology is the 
combination of Bus topology and the 
Star topology. This type of network 
arrangement, can have multiple 
servers. This topology is used when 
there are a large number of computers 
to be connected and there are distinct 
branches of an organization that need 
to be connected. It needs a lot of 
cables to be used and the success of 
the Tree topology depends largely on 
the cables installed.

5.Security of  Networks
When you installed a network, you 
enable a number of people to access and 
share important data stored in the 
computers on the network. For this 
purpose, the network requires to be 
secured. There are usually two ways in 
which a network can be secured. let us 
understand about both of these in a 
detail.
Login Security: Applying this security 
measure, all the users who want to 
access the data are provided unique 
user names and passwords. Only those 
people who have a username and a 
password can access the data.
Rights Security: Rights security is a 
step forward to login security. 
Applying this security measure, 
restricted access rights can be 

provided to users. Depending on the 
username, the access rights are 
restricted to particular folders, where 
the user can access only particular 
folders pertaining to his/her own 
work.

E. 1.Rahul use  a local area Network is a type 
of network that is used to connect 
personal computers in a room, building 
or campus. A  LAN is used broadly in 
offices as it allows its users to use 
resources such as printers, scanners, 
plotters, speakers, etc. on a common 
basis.

2. Mohit will use the PAN (Personal 
Area Networks). This may 
incorporate bluetooth enabled devices 
or infra-red enabled devices. PAN has 
connectivity range up to 10 meters. 
PAN may comprise wireless computer 
keyboard and mouse, bluetooth 
enabled headphones, wireless printers 
and TV remote.

My Activity
a. SERVER, b. CONNECTOR, c. 
TOPOLOGY, d. CIRCULAR, e. LOGIN

CH-2 LOG  ON  TO  MS ACCESS
Exercises
A. 1. MS Access, 2. Management, 3. Navigation, 

4. Alpha  Numeric, 5. Primary key
B. 1. True, 2. False, 3. False, 4. True, 5. True
C. 1.(a), 2.(c), 3. (c), 4. (b), 5. (b)
D. 1. (c), 2.(d), 3.(a), 4. (e), 5. (b)
E. 1.Components of Microsoft Access 

Window 
Title Bar
It shows the name of currently opened 
database.
File Tab
It displays the backstage view of file 
commands, like New and Open.
Quick Access Toolbar
It shows quick access buttons to the 
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Save, Undo and Redo commands.
Ribbon
It displays groups of related 
commands in tabs. Each tab provides 
shortcut button to common tasks.
Database Object
An Access database has four main objects– 
Tables, Queries, Forms and Reports. These 
objects are displayed in the Navigation 
Pane.
Navigation Pane
It contains all available database objects.
Status Bar
It displays information about the 
current object or view.
Work Area
It differs according to database element 
selected.

2.A database is a collection of information 
that is organized so that it can be easily 
accessed managed and updated. For 
example, you must have a telephone 
directory in which you maintain all the 
contact details of your friends. The 
contact details would include the 
telephone numbers, addresses and the 
email addresses of your friends. This 
telephone directory can be called your 
database.
Advantages of Using Database
The main advantages of using database 
are as follows:
Minimum data redundancy: Database 
system stores data at one place in the 
database. The data is integrated into a 
single, logical structure. Different 
applications refer to the data from the 
centrally controlled location. The central 
storage of the data reduces data 
redundancy.
Minimum data inconsistency: It also 
helps us to minimize data inconsistency. 
Updating of data values is simple and 
there is no disagreement in the stored 

values. For example, students home 
address is stored at a single location and 
gets updated centrally.
Improvement in data sharing: Data 
sharing refers to sharing the same data 
among more than one user. Each user 
has access to the same data, though they 
may use it for different purposes. The 
database is develop to support shared 
data. Authorised users are allowed to 
use the data from the database.
Improvement in data integrity: The 
database you have created is very 
important for you and it needs 
protection. The database is kept 
secured by limiting access to the 
database by authorised user.
Standardisation of data: Since the data 
is stored centrally, it is easy to enforce 
standards on the database. Standards 
could include naming conventions and 
standard for updating, accessing and 
protecting data.

3. A blank database comprises only a 
single blank table. After creating a 
blank database, you can add tables, 
forms, reports and other objects to it.
To create a blank database, follow the 
steps given below:
v Select Blank database option in the 

File tab.
v Type a name for the database in the 

File Name box.
v Click on Create.

4. To create a new table in Design View, 
follow the steps are given below:
vOpen the database and click on Create 

tab on the Ribbon.
vThe Table Tools tab will displays on 

the top of Title bar, Select Design tab.
v In the Field Name column, enter the 

name of the first field for example 
Employee _ID.

v Press the Tab key to move the 
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insertion point to the Data Type 
field.

vTo alter the data type, click on the 
drop-down arrow and modify the 
data type as per your choice.

v Press the Tab key to bring the 
insertion point to the Description 
column. Enter your text as the 
description in Description column.

v Press the Tab key again to move to the 
Field Name column in the second 
row and enter the text in the column.

vYou will notice the word 'Text' 
currently appeared in that field.

v Press Tab key to move the insertion 
point to Data type column.

v Press the Tab key to move the 
insertion point to Description 
column. Enter the text for the 
column.

vRepeat the steps to make the rest 
entries. The table is now complete.

5.To add records to a table, follow the steps 
given below:
vDouble-click on table Personal detail 

in the Database window.
vType the ID Number in the first 

Employee_ID field.
v Press the Tab key to complete other 

entries for the Employee_ID 1001. 
Type the following entries pressing 
the Tab key after each one to 
complete the record.

vAfter entering the last entry, contact 
number, press the Tab key. The 
insertion point comes to the ID field 
in the second row.

v Enter the remaining records follow 
the same steps as you used to add the 
first recording.

vWhen you complete entering data, 
click on Save button to save the 
changes. MS Access saves the table 
and you can see the name of the table 

in the Navigation table.
6.Understanding Field Properties

Each field has a set of properties that 
signifies and controls it. These 
properties contain basics like its size 
and format, as well as rules for entries 
in it.
Properties Pane
When a field is selected in Design View, 
its properties displays in the lower pane.
General Tab
The General Tab comprises most of the 
properties you will work with.
Lookup Tab
The Lookup Tab is mainly used for 
setting up lookup lists.
Drop-down Lists
Some properties have drop-down lists. 
Click the arrow to open the drop-down 
lists.
Property Information
When the insertion point is in 
property's box, information about that 
property displays here.
Yes/No Properties
Some properties illustrate yes/no 
questions, these are typically already 
filled in for you with default values.
Setting Field Size Properties
The default field size for a field with a 
data type of text is 255 characters. You 
can modify this size in the range of 0-
255 characters.

7. Data Type: Each field has a data type  
that specifies what you can store in it. 
Data entry is limited to valid entries for 
the type you select, which helps prevent 
data entry errors. For example, you 
cannot enter letters in a field set to 
Number, and you must enter valid 
dates or times in a Date/Time field.
Text: It enables to enter alpha-
mumeric characters. It has a limit of 
255 characters and it cannot be used 
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for numeric calculations. For eg. 
telephone numbers and ZIP codes.
Memo: It has a limit of 63,999 
characters are used for detailed, 
descriptive fields.

E. 1. Anmol is using a Data sheet view to add 
a table. 
v Click on the Create tab on the 

Ribbon.
v Click on the Table option. MS Access 

will open a new table in Datasheet 
View.

v Double-click the column header to 
create a field name. Type a name for 
the field.

v Press Enter key from the keyboard.
v Click on the next column. The Data 

Type menu will display.
v Select the data type for the field, 

example select Text, if you want to 
add the Name to the field.

v Type a name for the field.
v Click inside the first field of the first 

row and type the data to enter the 
first records.

v Press Tab key.
v Type the next field's data.
When you reach the last field. You can 
press Enter to start a new record.

2. Mansi used Access to write the 
description for the field of the table by 
press. Press the Tab key to bring the 
insertion point to the Description 
column. Enter your text as the 
description in Description column.

CH-3 MORE FEATURES OF MS ACCESS
Exercises
A. 1. Look, 2. Datasheet, 3. Foreign key, 4. 

Form Wizard, 5. Toggle Filter
B. 1. True, 2. True, 3. True, 4. False, 5. False
C. 1. (a), 2. (c), 3.(b), 4. (b), 5. (c)
D. 1. Find and Replace commands are also 

useful in MS Access when you have to 
find and replace something in a large 

database. Find enables you to quickly 
search tables, queries and form quickly 
for specified database task. Select a field 
to search through all records in the 
current field only.

2. To crate an AND criteria statement, 
follow the steps given below:

   v Click on the Emp_Name field, click 
on the Name list arrow and select the 
name Rakesh Arora of Employee 
from the list.

v Click on the Toggle Filter option MS 
Access uses the filter and shows only 
those records whose Designation 
field equals "Graphic Designer" AND 
whose Name field equals "Rakesh 
Arora". Only one record meets the 
filter criteria.

3. In MS Access, we can sort records in a 
specific order, ascending or descending.

    You can change the order of records in a 
table. This can enable you find, 
categories and analyze data.

 To sort the records, follow the Steps 
given below.
v Open the table where you want to 

sort records.
v Click on the column header for the 

field that to be sorted.
v Click on the Home tab on the 

Ribbon.
v Click on either of the Sort options.
v Click on Ascending to sort the 

records in ascending order.
v Click on Descending to sort the 

records in descending order.
4. To filter data using Filter by Form, 

follow the steps given below:
v Open the table if it is not already 

open.
v Click on Home tab on Ribbon.
v Click on Advanced option drop-

down arrow located in Sort & Filter 
group.
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v Click on Filter By Form.
v In the Filter by Form window.
v Select the field and value that to be 

used as criteria.
v Select Department field. Click on 

the Department drop-down arrow.
v Select "Sales" from the list. This will 

contain only records whose 
department comprises "Sales".

5. To add a new field, follow the steps 
given below.
v Right- click the name of the field 

that you want to be displayed after 
the new field. A menu will emerge.

v Click on Insert Field. A new field 
displays in the table. MS Access will 
assign a name to the new field as 
Field 1. Now, you can rename the 
field name and add information to it.

You can remove a field that is not 
required in a table.
To delete a field in the table, follow the 
steps given below:
v Right-click on the field that to be 

removed. A menu will display.
v Click on Delete Field. A prompt box 

displays.
v MS Access removes the field and 

record content for the field from the 
table.

6. Switch to Design View
  To use Design View, follow the steps 

given below:
    vClick on the Home tab on the 

Ribbon.
v Click on the View option drop-down 

arrow.
v Click on the Design View.
v MS Access will show the design of the 

table and display the field properties.
Switch to Datasheet View
To switch to Datasheet view, follow the 
steps given below:
v Click on the Home tab on the 

Ribbon.
v Click on the View option drop-down 

arrow.
v Click on the Datasheet View. MS 

Access shows the default Datasheet 
view of the table.

E. 1. Filtering data by form allows you to 
filter by multiple fields and define 
criteria for as many fields as you like. 
When you filter by form, you can 
merge the criteria using AND, OR or a 
amalgamation of the two. An AND 
combination finds records where both 
criteria are met; OR combination finds 
records where at least one criterion is 
met.

2.  Switch to Design View
     To use Design View, follow the steps give 

below:
v Click on the Home tab on the Ribbon.
v Click on the View option drop-down 

arrow.
v Click on the Design View.
vMS Access will show the design of the 

table and display the field properties.
CH-4             WORKING WITH

      QUERIES/FORMS/REPORTS
Exercises
A. 1. Query, 2. Criteria, 3. Sort, 4. Form, 
5. Report
B. 1. True, 2. True, 3. True, 4. True, 5. True, 6. 

True, 7. False, 8. True
C. 1. (b), 2.(c), 3.(c), 4.(b), 5.(a)
D. 1. A Query is a simple question that you 

ask to find a particular information from 
the database. Similarly in Access, when 
you create a query, you are defining 
particular search conditions. You can 
queries to view, change, summerize and 
analyses the particular data in different 
ways. 
2. Criteria: It includes the condition on 
the basis of which the records will be 
filtered in the Query output. We identify 
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criteria in the Criteria row of the design 
grid. Define the criteria value in the 
Criteria row and the data will be filtered 
accordingly in the query output.

The Simple Query Wizard screen displays as 
shown in the figure. Select the table that 
includes the data in the Tables/Queries 
list box.

Now, add the fields that you want to have in 
the query result.
4. A form is a piece of paper, on which a 
user fills the desired information in the 
particular fields. Similarly, in Microsoft 
Access 2016, Forms perform quite 
similar to it. Forms enable you to add and 
update data in one record at a time in a 
table. Although Access provides a 
Datasheet View, which is a suitable way of 
entering data, but it is not a convenient 
tool for every data entry situation.

To format a form using design tab, follow the 
steps given below:
v Click on Logo in the Header/Footer 
group. The Insert-Picture dialog box 
display. Select any picture and click OK.
v Click on Title  in the Header/Footer 
group.  Enter “Students Query as the 
Title for the Form.  
v Click on Date and time in the 
Header/Footer group. The Date and 
Time dialog box will display. Choose the 
required format of the Date and Time 
and click OK.
v Click on Themes in the Themes group. 
Click on the desired theme from the 
drop-down menu.

5. Exporting A Report
  v Click on the drop-down arrow of the 

View button on the Home tab and select 
Print Preview from the drop-down list of 
options.
v The report will be opened in the Print 
Preview layout and the ribbon will show 

the commands associated with the Print 
Preview layout.
v On the Data group, click on the drop-
down arrow of the More button and select 
Word.
v The Export-RTF File dialog box will 
display on the screen. Select the location 
where you want to save the report and 
give a suitable name to the report.
v Click OK.
v A final screen will display on the 
screen informing you about the 
successful completion of the exporting 
process.
v Click on the Close button.
v Find the word file where the report has 
been exported and open it.

E. 1. Madhu open the table that contain the 
information about percentage. 
v Click on the Database Tools tab. Select 
the Relationships button from the 
Relationships group.
v The Show table dialog box emerges, 
select the desired table and click on the 
Add button. The selected table will 
display in the object Relationships 
window. Similarly, add another table to 
the Relationships window.
v You can start the 'Queries' tab if your 
relationships are based on queries, or 
Start ' Both' tab if relationships are based 
on both-Tables and Queries.
Click on the Close button to close the 
Show Table dialog box.
v Move the Primary key of the parent 
table (e.g., Students Table) and drop it 
over the same field in the child table (e.g., 
Marks Table). In our example, Roll No is 
the primary key.
v The Edit Relationships dialog box 
displays.
v Click on the Create button. Access 
creates the relationship between the 
tables.
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A line linking the two tables will 
appear denoting that both have been 
linked on the basis of the linked field.
v Click on the Save button on the Quick 
Access Toolbar to save the relationship 
and then close the Relationships window 
by clicking on the Close button on the 
Relationships group.
2. To make a form, select a table or query 
in the Navigation Pane that you want to 
use as the data source for the form.
v Click on the Create tab on the Ribbon. 
Select the Form option in the Forms 
group.
v A new form is created and opens in the 
Layout view, in which you can modify the 
look of form. You will observe that three 
new tabs: Design, Arrange and Format 
display on the Ribbon.
v If you want to modify or enter data in 
the form, click on the Home tab> View 
button> Form View.
v Use the Record Navigation Bar to 
move through the records in the form.
v After completing the data entry, save 
your work by clicking on the Save option 
in Quick Access Toolbar or the Save 
option in the File tab. You will notice that 
the Form object gets added in the 
Navigation Pane.

CH-5 USING LISTS AND TABLES 
           IN HTML 5
Exercise
A. 1. List, 2. Unordered, 3. Border-spacing, 4. 

Reversed, 5. Description
B. 1. False, 2. True, 3. True, 4. False, 5. True
C. 1. (a), 2. (b), 3.(a), 4. (b), 5. (c)
D. 1.An unordered list is applied when the 

items are not to be displayed in any 
specific sequence. The list starts end 
with <ul and </ul> tags respectively. It 
indents each item in the list and 
incorporates a bullet against each of 
them. 

v The ordered list is used to show the list 
of items in a particular order. The list 
starts and ends with <ol> and </ol> tags 
respectively. Ordered lists are generally 
used in situations where order of the 
items is important or where it is needed 
to keep a count of the number of items.

2. HTML supports different elements to 
creates a list for displaying items in 
particular order. A list can be specified 
in different styles. The types of list that 
HTML provides are:
Unordered List, Ordered List, Description 
List
1. Unordered List: An unordered list is 

applied when the items are not to be 
displayed in any specific sequence. 
The list starts and end with <ul> and 
</ul> tag respectively.

2. Ordered List: The or ordered list is 
used to show the list of items in a 
particular order. An ordered list 
incises and gives a number to each 
item in the list that is why it is also 
called the Numbered list.

3. Description List: A description list 
comprises a term followed by its 
definition. It is used to present a 
glossary, list of terms or other 
name/value list. It begins and end 
with <dl> and </dl> tag respectively.

3. Tables are very popular on the web 
since they are flexible and an effective 
way of presenting information in the 
form of rows and columns.

To make a tables in HTML, <table> tag 
is applied. Each table starts with a 
<table> tag and ends with </table> tag.

Each row in table starts with the <tr> 
table row tag and optionally end with 
the </tr> tag. Rows must be placed 
inside the <table> tag. The columns 
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consists of cells, each of which starts 
with the <td> table data tag and ends 
with </td>tag. <td>tag must always be 
present inside the row tags <tr>. To 
define a column heading, we apply the 
<th> tag that also ends with </th> tag. 
It creates the text bold. The <caption> 
tag is applied to define the title for the 
table.

4. (a) List-Style-Image:
You can define an image as the list 
item marker with this property.

      SYNTAX : list-style=image:value
       where value = url (“path of the 

image")|none
  (b) List-style: This is the shorthand 

feature wherein all the list features 
can be defined in one declaration.

   SYNTAX : list-style:value
        Where value = value for list-style-

type value for list-style-position 
value for list-style-image.

(c) Empt-cells: This property allows in 
defining whether or not the border 
and background are to be put 
around empty cells in a table.

  SYNTAX : empty-cells:value
       where value = show (default)| 

                      hide
E. 1. With this property one can define 

whether the table borders are to be 
collapsed into a single border or 
detached (as usual).

SYNTAX: border-collapse:value
 Where value = separate |collapse

Example: border-collapse:collapse
2. Monika should use the list-style image 

property. In this property. She can 
define an image as the list item maker.

SYNTAX : list-style-image:value
Where value = url ("path of the 

image") |none

CH-6 IMAGE  LINKS & FRAMES 
          IN  HTML5
Exercises
A. 1. <img>, 2. ALT, 3. Hyperlinking, 4. 

internal, 5. Frames, 6. border-style
B. 1. True, 2. False, 3. False, 4. True, 5. True, 

6. True
C. 1. (a), 2. (b), 3. (c), 4. (c), 5. (b), 6. (c)
D. 1. The <img> tag is applied to add images 

in an HTML web page. It is an empty tag 
and needs different features to be 
defined with it. These features for the 
<img> tag indicates the browser how to 
layout the page so that text can flow 
appropriately around the image.
Attributes of an image elements:
Defining the Source of an Image
To add and specify the source of an 
image on a web page, the src feature is 
used. 
SYNTAX: <img src = "Address or path 
of the image file"
While defining the image file, one 
should be well aware of its location i.e., 
where the file stays.
The HEIGHT feature defines height (in 
pixels) for an image either in the form of 
an integer or a percentage value.  

The WIDTH feature defines width (in 
pixel) for an image either in the form of 
an integer or a percentage value.
To align an image to the right or left of a 
text, use the CSS property-float
Example: <p> <img src = "imag1.jpg" 
style=float:right;width:50px,heights50px>
Image will display to the right of the 
text. </p>.

2.Many a times a browser on the user's 
computer does not show images due to 
some reasons (may be because of slow 
connection or error in the src attribute). 
In that case, you can display the text to 
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give a description about the ALT 
attribute allows you define the text as an 
alternate to the image. The only 
purpose of ALT feature is to give a 
description of the contents of an image 
file. It is usually applied when the user is 
having a text-based browser on his 
computer like Lynx. It also proves to be 
beneficial when the user is a blind surfer 
for whom the browser is programmed 
to read aloud the alternate text rather 
than displaying the image. In situations, 
people have the image display disabled 
on their browsers or use settings that do 
not support automatic loading of 
images. In such situations ALT feature is 
applied.

3. A websites comprises a number of 
web pages that provide you access to 
related information. HTML gives a 
powerful feature of linking these web 
pages together. This feature is called 
Hyperlinking. Applying these 
hyperlinks, one can open any linked 
web page on the Internet instantly. 
When you place the mouse pointer 
over a link, it will turn into a little 
hand.
Types of Linking
1.)InternalLinking  2.)External Linking
1.)Internal Linking: When one part of 
a web page is linked to another part on 
the same page, it is called internal 
linking.
2.)External linking: When one page is 
linked to another web page or website, it 
is called external linking.

4. Inserting Audio: HTML 5 specifies a 
new tag-<audio> tag that defines a 
standard way to place an audio file in a 
web page. It can be used for any file 
format like mp3, ogg, wav etc.
<html>
<head>

<title>Adding Audio Clip</title>
<style type = "text/css">
body {background-color:RGB(255,251,214)}
</styles>
</head>
<body>
<h3 style = color:blue> we can't help 
everyone, can help someone.</h3>
<audio controls
Src = "C:\Users\UserDesktop\Kalimba.mp3">
Your browser does not support the 
audio tag.
</audio> </body>
</html>

          Place Video:
We can place video files in our HTML 
pages with the help of Video tag. 
Supported file formats include: .mp4, 
.webm, .ogg.  The <video>tag are given 
below.
<html>
<head>
<title>Video</title>
<body>
<h1> A Video Clip</h1>
<video controls src =
 "C:\Users\USer\Desktop\video1.mp4"
Width = "720" height = "540" autoplay>
Your browser does not support the 
video tag.
</video>
</body>
</html>

5.Frames are a way of organizing your 
website. They allow the user to divide a 
page into number of rectangular 
segments for various purposes.
Frames enable multiple HTML 
documents to be presented as 
independent window within one 
browser window. This gives greater 
flexibility to design and maintain your 
site than simply dumping everything 
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onto one page. Frames make your site 
interesting as you can incorporate the 
site theme (image, logo, banners, etc.). 
The navigation menu in frames is not 
to be downloaded each time when you 
visit a new page, only you have to 
change the contents of the page.

E. 1. Rekha will use ALT attribute on the 
image element. The ALT attribute value 
should be less than 100 character and 
should be as concise as possible.
Images that convey information: 
Images that convey information should 
not be defined as background images 
useless a text equivalent is provided in 
HTML code that can be seen in 
Windows High Contrast mode.
Active Images: If the image identifies a 
specific state, the alt text should also 
describe the state.
Large Images: Large images include 
charts, graphs, diagrams and even some 
photos. To make these images 
accessible provide a short all-text on the 
image and have information also 
presented in an alternative formal such 
as-table, list or text so that non-visula 
users can get the same information.

2. Rohit will use these given tags to link an 
image.
<html>
<head>
<title> Adding Image link </title>
</head>
<body>
<img src = “ Typres of computer. jpg">
</body>
</html>
To placing video clip, Rohit will take 
following steps.
<html>
<head>
<title>video</itle>

<body>
<h1> A video clip </h1>
<video controls src =
 "C:\User\Desktop\Video1.mp4."
Width = "720" height = "540" auto play>
</video>
</body>
</html>

CH-7 INTRODUCTION TO VISUAL BASIC
Exercises
A. 1. Instruction, 2. BASIC, 3. Top, 4. Caption, 

5. flat
B. 1. True, 2. True, 3. True, 4. True, 5. False
C. 1. (b), 2. (b), 3.(b) 4. (c), 5. (a)
D. 1. (b), 2. (d), 3.(e), 4.(c), 5.(a)
E. 1. Visual basic different from the BASIC 

in many ways. Visual Basic (VB) is an 
object- oriented language. In BASIC, 
programming is performed in a text-
only environment however in Visual 
Basic, programming is performed in a 
graphical environment. So, Visual 
Basic provides GUI (Graphical User 
Interface) features. In BASIC, if you 
have to write program code for 
graphical object, you need to define its 
position and other features by writing 
statements. However, in Visual Basic 
you just require to drag and drop any 
graphical object anywhere on the form 
and you can change its properties by 
using the Properties window.

2. Properties: Properties specify the 
name of the form or an object. The 
common properties of the form are 
given below.
Name: It defines the name of the form 
by which it is referred to in the code. 
The default name of the form is Form1.
Caption: It provides the title of the 
form.
Appearance: It can have different 
values. The values 0 creates the form 
look flat, while the value 1 creates the 
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form look three-dimensional.
Font: It is used to define the font type, 
font style and font size for the text.
Font Color: This property sets the colour 
of the form.
BackColor: This property sets background 
colour of the form.

Enabled: It can have True or False value. 
The value True allows the form respond 
to mouse and keyboard events, while 
the value False allows it unable to 
respond.

Visible: It can also have True or False 
value. The value True causes the form 
visible, while the value false causes it 
invisible.
Methods
Methods are the actions performed on 
the form or objects. The common 
methods of the form are given below.
Show: This method causes the form 
visible. It is the same as setting a form's 
visible property to True.
Hide: It makes the form invisible.
Print: It shows text string on the form.
Events:
 An event is a message sent by an object 
denoting that something has occurred. 
The common events of the form are 
given below.
Form-Click: When the user clicks on 
the form, Form-click event is triggered.
Form-Load: When the form is loaded, 
Form-load event is triggered.

3. In Visual Basic, an application is created 
in the following three steps:
v Design the interface
v Set properties of the controls(Objects)
vWrite the event procedures

4. The command button is applied to carry 
out commands. When the user clicks on 
the command button, it displays an 
illusion that the button is pressed. Some 

important properties related to command 
button are given below.

Appearance: It can be 3D or flat in 
appearance.

Caption: It is the text displayed on the 
command button.

Visible: It can have the value True or 
False depending upon whether it is 
visible or not.

Enables: It can have the value True or 
False depending upon whether it 
responds to an event or not.
An event related to the command 
button is Clicked, which is triggered 
when it is selected by clicking on it.

5. To start Visual Basic, follow the steps 
given below.
v Click on the Start button.
v Select All Programs option from 

the Start menu.
v Click on the Microsoft Visual Studio 

6.0 option.
v Select Standard. EXE option from 

the New tab of New Project window 
and click on the OK button.

v Microsoft Visual Basic Window 
will display on the screen.

E. Tarun should be used Microsoft Excel 
because Microsoft Excel useful in computing 
and managing grades. It has features like, 
calculate the total, percentage and grade etc.

CH-8  INTRODUCTION TO JAVA
Exercises
A. 1. access, 2. Arithmetic, 3. Benefits, 4. 

Standard, 5. Java, 6. Objects, procedures, 
7. Compiled, 8. Data, 9. Encapsulation

B. 1. False, 2. True,3. False, 4. True, 5. True
C. 1.(a), 2.(c), 3. (b), 4. (c), 5. (b)
D. 1.(a), 2. (e), 3. (d), 4. (c), 5. (b)
E. 1. Java is a programming language that 

produces software for multiple 
platforms.
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The basic features of Java are listed 
below.
v Java is strongly type programming 

language. For example, the types of 
used variables must be pre-defined 
and conversion to other objects is 
relatively strict.

v Java is an object-oriented language 
providing features such as 
inheritance, polymorphism and 
abstraction.

v Java programs can access data both 
from local machines and the web.

v Java can be used to develop 
distributed applications across the 
networks and the Internet.

v Data in Java is specified as objects 
and procedures.

v Java programs can be carried out on 
any platform that have Java-enabled 
Internet browser.

2. Object means a real word entity such as 
pen, chair, table etc. Object-oriented 
programming is a methodology to design 
a program using classes and objects. In 
object-oriented programming, a problem 
is viewed not as sequence of steps to be 
done but as a collection of different units 
(called objects) that model the real world 
things.
Let's know about the basic terminology 
used in object-oriented programming 
(OOP).
Object: The fundamental idea behind 
OOP is to store the data and functions 
operating on-that data into a single 
unit called an object. An object may 
represent a person, a student, an 
employee, an account, an examination 
or any item that closely resembles the 
objects of real world.
Class: A class is a collection of similar 
objects. For example, different kinds of 
fish come under the category of class.

Encapsulation: Binding (or wrapping) 
code and data together into a single unit 
is known as encapsulation. For 
example, capsule. It is wrapped with 
different medicines.
Data Hiding: Data hiding is the 
important feature of objects, by which 
data are not made accessible for other 
functions outside the objects.
Data Abstraction: In java, hiding 
internal details and showing functionality 
is know as abstraction. Classes use this 
concept and represent essential properties 
of the objects.
Inheritance: When an object of one 
class (base class) can inherit the 
properties of another class (derived 
class) by a process called inheritance. 
For example, petrol vehicle is a class 
that inherits the properties of another 
class, vehicle.
Polymorphism: When one task is 
performed by different way i.e known 
as polymorphism. For example, to 
convince the customer differently to 
draw something e.g shape or rectangle 
etc.
Reusability of the code is the major benefit 
of  object-oriented programming.

3. In order to develop applications on Java, 
we first need to install Java Development 
Kit (JDK ver. 1.5 or 1.6) in our computer. 
Then, we follow the three-step procedure 
to develop applications.
v Enter the program in Notepad.
v Compile the program with Java 

Compiler (javac).
v Run the program in Java.
Entering the Java Program
Java program is entered into the 
computer using a text editor such as 
Notepad. To enter the program using 
Notepad, follow the steps given below.
v Click Start à All programs à 
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Accessories à Notepad menu options 
to load Notepad.

v Type the program in the New 
Document.

v Choose File  Save menu option in 
the Notepad to save the program.

v Click All Files option in the Save As 
type box of the Save As dialog box 
and type the name of the file with 
extension name java in File name 
box.

v Then, click on the Save button.
Compiling the Java Program
Java program is compiled at the DOS 

prompt. So, you need to go to the 
Command prompt in order to compile 
your program. Now, to compile the Java 
program, follow the steps given below.
v Click Start All Programs Accessories 

Command Prompt menu options for 
accessing the DOS prompt.

v In DOS prompt, change to that 
directory (folder) where your 
program is saved by typing the DOS 
command, cd <folder name>.

v To compile the program, type Java < 
file name with extension>. The 
program will be compiled.

Running the Java Program
In order to run the compiled Java 
program, type the command, java < file 
name without extension>. The program 
will run and you will get the output.

4. It refers to the type of data that can be 
used in a program. There are two kinds of 
data types in Java-Standard and Derived. 
Standard data types are built into the Java 
language, which includes the following 
data types.
v Byte: 8 bit byte-length integer data 

type with range - 128 to 128 (signed) 
and 0 to 255 (unsigned)

v Short: 16 bit short integer data type 
15 15-1with range - 2  to 2

v Int: 32 bit integer data type with range  
31 31-1- 2  to 2

v Long: 64 bit long integer data type 
63 63-1with range - 2  to 2

v Float: 32 bit single precision floating 
39point data type with range up o 10

v Double: 64 bit double-precision 
floating point data type with range 

317up to 10
v Char: 16 bit single-character data 

type.
v Boolean : 1 bit Boolean data type with 

True/False value
Derived data types are based on 
standard data types. For example, a 
string which is based on char data 
type. Can store alphabets, digits and 
other characters including space.

5. Operators are the symbols such as 
+,*,++,––,etc. used for different 
purposes in a program code. There are 
many types of operators used in Java. 
Following are the common types of 
operators given below.
v Relational Operators
v Arithmetic Operators
v Increment and Decrement Operators
v Logical Operators
Relational Operators
Relational operators are used to 
compare the values of two variables. 
Following are the operators which they 
include.
v > : Is used to find whether the first 

number is greater than the second, 
for example num1 > num2

v < : Is used to find whether two 
numbers are equal, for example, 
num1 < num 2

v = = : Is used to find whether two 
numbers are equal, for example, 
num = = num 2

v ! =: Is used to find whether two 
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numbers are not equal, for example, 
num 1! = num2

v >= : Is used to find whether the first 
number is greater than or equal to 
the second, for example, num1> = 
num2

v <= : Is used to find whether the first 
number is less than or equal to the 
second, for example, num 1 < = 
num 2

Arithmetic Operators
Arithmetic operators are used for 
various arithmetic calculations. They 
include the following operators.
v + : Is used to add two numbers, for 

example, num 1+ num2
v – : Is used to subtract two numbers, 

for example, num 1 – num 2
v * : Is used to multiply two numbers, 

for example, num 1 * num 2
v / : Is used to divide two numbers, for 

example, num1/num2
v % : Is used to calculate the 

remainder on dividing two 
numbers, for example, num 1% 
num 2

Increment and Decrement Operators
Increment operator + + is used to add 1 to 
the value of a variable, while decrement 
operator - - is used to subtract 1 from the 
value of a variable. For example, num ++ 
will add 1 to the value of a variable num 
and num --will subtract 1 from the value 
of a variable num.
Increment and decrement operators + 
+ and - - can also be placed before the 
name of variables (such as + + num and 
- - num), but they may give different 
outputs depending upon the logic of a 
program.
Logical Operators
Logical operators are used to find 
whether one or both the conditions are 

true or false. Following are the operators 
which they include.
v &&: Is used to find whether both the 

conditions are true, for example, 
num 1 && num 2

v !! : Is used to find whether one of the 
two conditions is true, for example, 
num 1 !! num 2

v !: Is used to find whether the 
condition is false, for example, !num

6. (a) Main () method: It is the method 
that is always executed first.
Print ln() method: It shows the 
output on the screen.

          (b)System Class : It contains all that are 
methods that are required to run a 
java program .It  provides a 
standard interface to common 
system resources

(c)Out Object: It represents the 
standard output device.

7. For loop statement: It contains the 
statements that are repeated based on 
the increment or decrement condition 
as illustrated in the following example.
for (i=0, i<=5; i + +)
{

System.out.printIn(i);
}
The above code will display the 
numbers from 1 to 5.
The syntax of for loop statement is as 
follows.
for (intial-value; termination-condition; 
increment/decrement value)
v While loop statement: It contains 

the statements that are repeated until 
the conditional expression is true as 
illustrated in the following example.
while (1 < = 5)
{

System.out.printIn(i);
i + +
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}
The above code will also display the 
numbers from 1 to 5. The syntax of 
while loop statement is as follows.
while (condition)

{
statements

}
8. Gross salary is the final salary 

computed after the additions of DA, 
HRA and other allowances. The 
formula for DA and HRA is:
# inculdue <studio.h>
int main ()
{
float basic. gross. da, hra;
/* Input basic salary of employee */
printf (*Enter basic salary of an 
employee:");
scanf ("%", & basic);
/* calculate D.A and H.R.A according 
to specified conditions */
if (basic < = 10000)
{

da = basic * 0.8;
hra = basic * 0.2;

}
else if (basic < = 20000)

{
da = basic * 0.9;
hra = basic * 0.25;

}
else
{

da = basic * 0.95;
hra = basic * 0.3;

}
/* calculate gross salary */
gross = basic + hra + da;
prinf ("Gross salary of employee = % 
2fgoss return O;
}

E. Ananya should use the Java in preparing 
result of her class
{
public static void main(String arg [ ]) 
{
int marks = 50; 
if (marks >= 30); 
System.out.println ("Your marks 
are"+marks+ "and you are passed"); else 
System.out.println ("Your marks 
are"+marks+"and you are failed"); }

CH-9 WINDOWS INSTALLATION AND
            TROUBLESHOOTING
Exercises
A. 1. Drivers, 2. User Support, 3. Trouble 

Shooting, 4. System, 5. Dick Partitioning
B. 1. True, 2.True, 3. False, 4. True, 5. True
C. 1(b), 2. (a), 3. (a), 4. (b), 5. (b)
D. 1. Troubleshooting refers to problem solving, 

which is often applied to repairing 
products, processes or systems. In 
computer terminology, troubleshooting 
often involves the process of determining 
and resolving any problem related with 
computer hardware and/or software. So, 
troubleshooting is a systematic approach 
to problem solving.
If you know the-process of 
troubleshooting, you can find and resolve 
many of the hardware and software 
problems yourself. Before discussing this 
process, let's first discuss what are various 
types troubleshooting.

2. The process of Windows 7 upgrade 
installation is described in the 
following steps.
v Insert the Microsoft Windows 7 

DVD in the DVD drive of your 
computer. The Setup exp program 
will launch automatically and the 
Setup files will be loaded in the 
hard disk.

v Now, choose your language, time 
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and currency format, keyboard or 
input method and click on the Next 
button as shown.

v The next screen will show. Click on 
the Install Now button.

v Now, you will see the Microsoft 
Software License Terms screen. 
Check'l accept the license terms' 
box and click on the Next button.

v In the next screen, click on the 
Custom (advance) option to install 
a fresh copy of Windows 7 as shown 
below.

v Now, choose the drive where you 
want to install Windows 7 and click 
on the Next button.

v During the fifth step, the computer 
will restart and installation will 
continue. This is the most time 
consuming step.

v The computer will restart again and 
the setup will continue to prepare 
your computer for first time use 
and check the video performance.

v After the fifth step, type your 
desired username and click on the 
Next button. If you want to set a 
password, type in the text boxes 
and click on the Next button.

v Now, yow need to enter your 
product key. Enter the key and click 
on the Next button.

v In the next screen, choose your 
desired option for windows update.

v Now, choose your time zone and 
enter the correct date and time in 
the next screen. Click on the Next 
button to continue.

v In the last step of Windows 7 
installation the set up will finalize 
the various setting and prepare the 
desktop as shown below.

3. There are two forms of installation- 
Upgrade Installation and Custom 

(Advanced) Installation.
Upgrade Installation versus Custom 
Installation.
v Where you simply start the 

installation inside of your existing 
operating system. It recognizes that 
an OS already exists, and it upgrades 
to the newest version of this 
operating system and makes sure 
that it keeps all your applications in 
place, and all of your files exactly the 
way they are.

v When you wish to retain your 
existing files or system configuration 
settings, you should upgrade your 
existing Windows Operating System 
by replacing the current windows 
files. Such an installation of 
Windows 7 is called Custom 
(Advanced) Installation.

4. Following are the basic steps of trouble 
shooting.
v Determine the Problem: In order 

to troubleshoot your PC, first you 
should analyze the nature of the 
problem such as:

v What messages is your system 
showing on the screen?

v Are you able to boot your PC?
v Are the power indicators of monitor 

and CPU on?
v Why has the problem occurred? 

Have you shifted your computer 
recently or loaded some software 
into it?

v Categorize the Problem: After 
analyzing you can categorize the proble 
into one of the five types of support - 
User, Software, Hardware, Operating 
System  and  Networking.

v Action Plan: During the action plan, 
first of all decide whether the problem 
can be fixed by the user or it needs a 
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technician. If the problem is relate 
with windows, you can go to the 
control Panel from the Start menu 
and fix the problem yourself. So, it is 
better to document your action plan 
and proceed further.

v Implement the Plan: If you have 
decided to resolve the problem 
yourself, proceed with the 
implementation of the plan. For 
software or operating system 
troubleshooting, you should 
follow the basic guidelines as 
given below.

v Always take backup of your data if 
you are able to boot your system 
before fixing the problem.

v If you are unable to boot your system, 
check all the cable connections and 
try to reboot the computer.

v If you have recently installed any 
software that could have caused 
windows to stop loading, try the 
windows recovery procedure 
through System Restore option 
from the Control Panel.

v Most of the software problems 
occur because of virus attack. So 
scan your system for viruses using 
an  antivirus.

v Run and Test the System: The last 
step in troubleshooting is to 
operate the computer for hours 
and text it properly to make sure 
that the problem has been 
resolved.

5. Sometimes, you need to remove 
unwanted files/programs stored on 
the hard disk. You can delete 
unwanted files and programs from 
your system by choosing any or both 
of these methods.

E. Sheena should use the software is cloud. It 
stores all the photos and videos in the 

computer and run a windows task to copy 
all the photos to another computer in 
home on a nightly basis for backup 
purposes. It essential to keep a set of all 
pictures online in the cloud.
Uploading photos to the cloud has a 
couple of advantages over storing them 
all locally.
1. It can easily share the albus with others.
2. It provides a backup of all your photos in 

case something happens to your local copy.
CH-10           INTERNET APPS
Exercises
A. 1. gadgets, 2. Skype, 3. Group Screen Sharing, 

4. Internet, 5. ARPA, 6. Plugin, 7. Blogs
B. 1. True, 2. True, 3. True, 4. True, 5. False, 6. 

False
C. 1. (a), 2. (c), 3. (b), 4. (a), 5. (c), 6. (a)
D. 1. Internet: The Internet, sometimes 

called simply 'the Net' is a worldwide 
system of computer networks-a 
network of networks in which users at 
any one computer can get information 
from any other computers (and 
sometimes talk directly to users at 
other computers. It was conceived by 
the Advanced Research Projects 
A g e n c y  ( A R PA )  o f  t h e  U. S .  
government in 1969 and was first 
known as the ARPA Net.

2. Multimedia: Multimedia is a term used 
to describe how multiple means of 
media like, text, audio, graphics, 
animation, video and interactivity are 
u s e d  t o  c o m m u n i c a t e  w i t h  
information. It is also often used to 
describe any computer media. This 
helps us to understand information at a 
faster way.

3. RSS: RSS(Rich Site Summary), often 
called (Really Simple Syndication) is a 
type of web feed which allow a user to 
access updates to online content in a 
standardized format. For example: 
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Allow a user to keep track of many 
different web sites in a single news 
aggregator. News and blog sites, 
medical websites, religious 
organization information pages. 
Checking such website repeatedly for 
updating is a difficult job. RSS proves 
to be helpful in such cases.
RSS Feed is refers to a list of items 
presented in an order from newest to 
oldest. Each item usually consists of a 
simple title briefly describing the 
updated content along with a complete 
description and a link to a web page 
with the actual information being 
described.

4. Live cams are another aspect of the 
multimedia available on the web. Live 
cams are video cameras that send their 
data in real-time to a web server.

5. Skype: is an IP telephy service 
provider that offers free calling 
between subscribes and low-cost 
calling to people who don't use the 
service. It includes telephone calls, 
Skype enables file transfer, texting 
video chart and video conferencing.
This service is available for desktop 
computers, notebook, tablet, computers 
and mobile  phone.
Features of Skype
v The Group Video Call feature of 

Skype enables you to make video 
calls that can involves as many as 25 
people at the same time.

v Video Messaging Feature lets you 
capture and share any moment of 
your day with your family and 
friends.

6. The real-time communication tools 
include:
Chat: Text message in real-time.
Audio: Conduct a telephone 
conversation on web.

Skype 

Video : View your audience.
File transfer: Send files back and forth 
among participants.
Document/application sharing: View 
and use a program on another's 
desktop machine.

7. Blogs are refer to a series of entries 
posted to a single page in reverse order. 
Blogs generally represents the 
personality of the author or reflect the 
purpose of the website that hosts the 
blog. The topic of the blog can be an 
anything from personal to professional. 
A blog is what you make of it. Blogging 
can be an interactive activity. Readers 
can add comments to blogger's 
postings, other persons, other persons 
can respond, and  a conversation issues. 
Lately bloggers have become well-
known commentators on the political 
scene, but blogging can encompass 
any topic or no topic at all.

E. 1. Ankit should use the skype to share his 
poem with the word using Internet. 
He will create a blog using given steps:
v Open the site www.blogger.com. 

The Blogger site will open. Click on 
the CREATE YOUR BLOG option.

v To create a blog with the blogger 
site, you must have your account (e-
mail) in Gmail. Else, you will have to 
create a new Gmail account.

v Sign in by applying your Gmail user 
name and password.

v The display page gives you two 
options to create your profile, i.e., a 
Google + profile or a Blogger 
profile. Click on the Create a limited 
Blogger  profile  button.

v Applying a name in the Display 
Name text box as shown on the 
screen. This name will appear as 
your signature in the articles you 
will post on this blog. Click on the 
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Continue to Blogger button and 
select the New blog option from the 
left pane.

v A dialog box appears, give a tittle for 
your blog, say 'My poems' in the 
Title text box. The title will appear at 
the top of every page of your blog. 
The title should reflect the contents 
of  your  blog.

v Applying the URL (address) of your 
blog in the Address: text box, say 
bhaskarips. blogspot.com. Your 
blog address (URL) will be your 
identity on the web and it will be 
used to read and link to your blog.

v Different templates for your blog 
will be displayed in the same 
window under the Template 
section.

v Click the template of your choice. 
Click on the Create blog! Button.

v Your blog has been created.
2. Harshit should use the skype to make a 

video call for conference. Follow the 
given steps to calling on Skype.
vTo make a call on the Skype, select the 

person you wish to call from the 
Contacts tab.

vThe information of the selected contact 
appears on the right pane.

vClick on the Call button if you wish to 
have voice call. Clicking the Video 
call button allows you to have voice as 
well as video calling.

vAfter using any of the selected facility, 
click the Skype > Sign Out option to 
close  your  account.

Model Test Paper- 1
A. 1. (a), 2. (b), 3. (a), 4.(a), 5. (a), 6. (a)
B. 1. Tree, 2. Navigation, 3. Look, 4. 

Datasheet, 5. MS Access
C. 1. False, 2. True, 3. True, 4. True, 5. False
D. 1. Wired Network: Electrical cables such 

as (twisted pair coaxial cable or optical 

fibre) are used to carry signals from one 
end to other.
Wireless Network: They do not 
require cables rather than signals are 
transmitted using Bluetooth, Infrared, 
Microwave or Radiowave.

2. Data Type: Each field has a data type  
that specifies what you can store in it. 
Data entry is limited to valid entries for 
the type you select, which helps prevent 
data entry errors. For example, you 
cannot enter letters in a field set to 
Number and you must enter valid dates 
or times in a Date/Time field.
Text: It enables to enter alpha-numeric 
characters. It has a limit of 255 
characters and it cannot be used for 
numeric calculations. For eg. 
telephone numbers and ZIP codes.
Memo: It has a limit of 63,999 characters 
are used for detailed, descriptive fields.

3. A data base is a collection of information 
that is organized so that it can be easily 
accessed,managed and updated. For 
example, you must have a telephone 
directory in which you maintain all the 
contact details of your friends. The 
contact details would include the 
telephone numbers, addresses and the 
email addresses of your friends. This 
telephone directory can be called your 
database.
Advantages of Using Database
The main advantages of using database 
are as follows:
Minimum data redundancy: Database 
system stores data at one place in the data 
base. The data is integrated into a single, 
logical structure. Different applications 
refer to the data from the centrally 
controlled location. The central storage 
of the data reduces data redundancy.
Minimum data inconsistency: It also 
helps us to minimise data inconsistency. 
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Updating of data values is simple and 
there is no disagreement in the stored 
values. For example, students home 
address is stored at a single location and 
gets updated centrally.
Improvement in data sharing: Data 
sharing refers to sharing the same data 
among more than one user. Each user 
has access to the same data, through 
they may use it for different purposes. 
The database is develop to support 
shared data. Authorised users are 
allowed to use the data from the data 
base.
Improvement in data integrity: The 
database you have created is very 
important for you and it needs 
protection. The database is kept 
secured by limiting access to the 
database by authorised user.
Standardization of data: Since the 
data is stored centrally, it is easy to 
enforce standards on the database. 
Standards could include naming 
conventions and standard for updating, 
accessing and protecting data.

4. To add a new field, follow the steps 
given below.
v Right- click the name of the field 

that you want to be displayed after 
the new field. A menu will emerge.

v Click on Insert Field. A new field 
displays in the table. MS Access will 
assign a name to the new field as 
Field 1. Now, you can rename the 
field name and add information to it.

v Delete a Field in the table.
v You can remove a field that is not 

required in a table.
To delete a field in the table, follow the 
steps given below:
v Right-click on the field that to be 

removed. A menu will display.
v Click on Delete Field. A prompt box 

displays.
v MS Access removes the field and 

record content for the field from the 
table.

5.  Find and Replace commands are also 
useful in MS Access when you have to 
find and replace something in a large 
database. Find enables you to quickly 
search tables, queries and form 
quickly for specified database task. 
Select a field to search through all 
records in the current field only.

E. 1. Effective Backup: In information 
technology, a backup, or the process of 
backing up, refers to the copying and 
archiving of computer data so it may 
be used to restore the original after a 
data loss event.

2. Ribbon: In computer interface design, 
a ribbon is a graphical control element 
in the form of a set of toolbars placed 
on several tabs. ... However, in 2007, 
Microsoft Office 2007 used the term to 
refer to its own implementation of 
tabbed toolbars bearing heterogeneous 
controls, which Microsoft calls "The 
Fluent UI".

3. Alpha-Numeric: The definition of 
alphanumeric is something that 
contains letters and numbers. A 
password that requires both letters 
and numbers is an example of an 
alphanumeric password. A computer 
keyboard is an example of an 
alphanumeric keyboard.

4. Modifying Table: Create or modify 
tables or indexes by using a data-
definition query. Applies To: Access 
2010. You can create and modify tables, 
constraints, indexes and relationships 
by writing data-definition queries in 
SQL view.

5. Wireless: A wireless modem is a 
modem that bypasses the telephone 
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system and connects directly to a 
wireless network, through which it can 
directly access the Internet connectivity 
provided by an Internet service provider 
(ISP).

Model Test paper-2
A.  1. (c), 2. (b), 3. (b), 4. (b), 5. (c), 6. (c)
B. 1. Internal, 2. Unordered, 3. Form, 4. 

Border Spacing, 5. Report
C. 1. False, 2. True, 3. False, 4. True, 5. True
D. 1. A Query is a simple question that you 

ask to find a particular information 
from the database. Similarly in Access, 
when you create a query, you are 
defining particular search conditions. 
You can queries to view, change, 
summarise and analyse the particular 
data in different ways.

2. Tables are very popular on the web 
since they are flexible and an effective 
way of presenting information in the 
form of rows and columns.
v To make a table in HTML, <table> 

tag is applied. Each table starts with 
a <table> tag and ends with </table> 
tag.

Types of Linking
Internal Linking External Linking
Internal Linking: When one part of a 
web page is linked to another part on 
the same page, it is called internal 
linking.
External linking: When one page is 
linked to another web page or website, 
it is called external linking.

E. 1. Flash Memory: Flash memory is a non-
volatile memory chip used for storage 
and for transfering data between a 
personal computer (PC) and digital 
devices. It has the ability to be 
electronically reprogrammed and 
erased. It is often found in USB flash 
drives, MP3 players, digital cameras 
and solid-state drives.

2. Markup Language: Markup languages 
are designed for the processing, 
definition and presentation of text. The 
language specifies code for formatting, 
both the layout and style, within a text 
file. The code used to specify the 
formatting are called tags. HTMLis a an 
example of a widely known and used 
markup language.

3. QBASIC: QBasic short form of Quick 
Beginners All purpose Symbolic 
Instruction Code is an IDE and 
interpreter for a variety of the BASIC 
programming language which is 
based on Quick BASIC. Code entered 
into the IDE is compiled to an 
intermediate representation, and this 
IR is immediately interpreted on 
demand with in the  IDE.

4. Link Break: On the Data tab, in the 
Connections group, click Edit Links. ... 
In the Source list, click the link that you 
want to break. To select multiple linked 
objects, hold down Ctrl, and then click 
each linked object.

5. Mask Layer flash: Masking is a way for 
you to control the content that your 
audience sees. For example, you can 
make a circular mask and allow your 
audience to only see through the 
circular area, so that you get a keyhole 
or spotlight effect. In Flash, you put a 
mask on one layer and the content that 
is masked in a layer below it.

Model Test Paper-3

A.  1 (c), 2. (a), 3. (a), 4. (b), 5. (c), 6. (b)

B. 1. Objects, Procedures 2. Group Screen 
Sharing, 3. Disk Partitioning 4. Flat, 5. 
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Data

C. 1. False, 2. False, 3. True, 4. False, 5. True

D. 1. Properties: Properties specify the name 
of the form or an object. The common 
properties of the form are given below.

Name: It defines the name of the form 
by which it is referred to in the code. The 
default name of the form is Form1.

Caption: It provides the title of the 
form.

Appearance: It can have different 
values. The values 0 creates the form 
look flat, while the value 1 creates the 
form look three-dimensional.

Font: It is used to define the font type, 
font style and font size for the text.

Font Color: This property sets the 
colour of the form.

Back Color: This property sets background 
colour of the form.

Enabled: It can have True or False value. 
The value True allows the form respond 
to mouse and keyboard events, while 
the value False allows it unable to 
respond.

Visible: It can also have True or False 
value. The value True causes the form 
visible, while the value false causes it 
invisible.

Methods:
Methods are the actions performed on 
the form or objects. The common 
methods of the form are given below.

Show: This method causes the form 
visible. It is the same as setting a form's 
visible property to True.

Hide: It makes the form invisible.

Print: It shows text string on the form.

Events: An event is a message sent by an 
object denoting that something has 
occurred. The common events of the 
form are given below.

Form-Click: When the user clicks on 
the form, Form-click event is triggered.

Form-load: When the form is loaded, 
Form-load event is triggered.

2. Sometimes, you need to remove 
unwanted files/programs stored on the 
hard disk. You can delete unwanted 
files and programs from your system by 
choosing any or both of these methods.

3. In order to develop applications on 
Java, we first need to install Java 
Development Kit (JDK ver. 1.5 or 1.6) 
in our computer. Then, we follow the 
three-step procedure to develop 
applications.
v Enter the program in Notepad.
v Compile the program with Java 

Compiler (javac).
v Run the program in Java.
v Entering the Java Program
Java program is entered into the 
computer using a text editor such as 
Notepad. To enter the program using 
Notepad, follow the steps given below.
v Click Start à All programs à 

Accessories à Notepad menu 
options to load Notepad.

v Type the program in the New 
Document.

v Choose File Save menu option in 
the Notepad to save the program.

v Click All Files option in the Save As 
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type box of the Save As dialog box 
and type the name of the file with 
extension name java in File name 
box.

v Then, click on the Save button.
v Compiling the Java Program
Java program is compiled at the DOS 
prompt. So, you need to go to the 
Command prompt in order to compile 
your program. Now, to compile the 
Java program, follow the steps given 
below.
v Click Start All Programs Accessories 

Command Prompt menu options 
for accessing the DOS prompt.

v In DOS prompt, change to that 
directory (folder) where your 
program is saved by typing the 
DOS command, cd <folder name>.

v To compile the program, type Java 
< file name with extension>. The 
program will be compiled.

v Running the Java Program
v In order to run the compiled Java 

program, type the command, java < 
file name without extension>. The 
program will run and you will get 
the output.

5. There are two forms of installation- 
Upgrade Installation and Custom 
(Advanced) Installation.

Upgrade Installation versus Custom 
Installation:
Where you simply start the installation 
inside of your existing operating 
system. It recognizes that an OS 
already exists, and it upgrades to the 

newest version of this operating 
system and makes sure that it keeps all 
your applications in place, and all of 
your files exactly the way they are.

When you wish to retain your 
existing files or system configuration 
settings, you should upgrade your 
existing Windows Operating System by 
replacing the current windows files. 
Such an installation of Windows 7 is 
called Custom (Advanced) Installation.

E. 1. Forms in Access: A form in Access is a 
database object that you can use to 
create a user interface for a database 
application. A "bound" form is one that 
is directly connected to a data source 
such as a table or query, and can be used 
to enter, edit, or display data from that 
data source.

2. Ordered List: Use the HTML <ol> 
element to define an ordered list. Use 
the HTML type attribute to define the 
numbering type. Use the HTML <li> 
element to define a list item. Use the 
HTML <dl> element to define a 
description list. Use the HTML <dt> 
element to define the description term.

3. Report in Microsoft Access: A report 
is an object in Microsoft Access that is 
used to display and print your data in 
an organized manner. The Navigation 
Pane is where you can find all of the 
saved reports in the database. To view 
your reports, make sure that all objects 
are visible in the Navigation Pane. 

4. Img HTML: The <img> tag defines an 
image in an HTML page. The <img> 
tag has two required attributes: src and 
alt. Note: Images are not technically 
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inserted into an HTML page, images 
are linked to HTML pages. ... Tip: To 
link an image to another document, 
simply nest the <img> tag inside <a> 
tags.

5. Border in excel: By Vangie Beal In the 
Microsoft Excel program, "borders" is a 
built-in tool that lets users access 
predefined border styles to add a 
border around two or more cells on a 
spreadsheet. You can also use the 
borders tool to create your own custom 
border.
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